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Introduction
This document describes how to use Event Studio to ensure that critical information is detected
quickly and delivered to key stakeholders in your business.
The following documents contain related information and may be referred to in this document. To
view these documents, either consult your administrator to determine the online location of
Cognos documentation or search the Knowledge Base of the Cognos Global Customer Services
Web site (http://support.cognos.comkb-appknowledgebase). If you require logon credentials,
either consult with your administrator or send an email to support.america@cognos.com.
Document

Description

Cognos 8 Getting Started Teaching new users how to use Cognos 8
Cognos 8 New Features

Describing features that are new in this release

Cognos Connection User Using Cognos Connection to publish, find, manage, organize, and
Guide
view Cognos content, such as scorecards, reports, analyses, and
agents
Cognos 8 Administration Managing servers, security, reports, and Portal Services; setting up
and Security Guide
Cognos samples; and customizing Cognos 8
Analysis Studio User
Guide

Exploring, analyzing, and comparing dimensional data

Map Manager
Installation and User
Guide

Installing and using Map Manager to import and manage maps that
are used in map reports

Query Studio User Guide Creating self-service business intelligence reports
Report Studio User Guide Authoring reports that analyze corporate data according to specific
needs
Cognos 8 Architecture
and Planning Guide

Planning the Cognos 8 architecture, developing installation
strategies, and optimizing performance

Framework Manager
User Guide

Creating and publishing models using Framework Manager

Metric Studio User Guide Authoring scorecard applications and monitoring the metrics within
for Authors
them
Data Manager User
Guide

Using Data Manager to create data warehouses and data
repositories

For more information about using this product, visit the Cognos Global Customer Services Web
site (http://support.cognos.com). For information about education and training, click the Training
link from this site.
This document is available as online help and as an online book.
Our documentation includes user guides, tutorial guides, reference books, and other materials to
meet the needs of our varied audience.
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Online Help
All information is available in online help. Online help is available from the help button in a Web
browser, or the Help menu and help button in Windows products. You can also download the
online help from the Cognos Global Customer Services Web site (http://support.cognos.com).

Books for Printing
The information in each online help system is available in online book format (PDF). However,
the information from a given help system may be divided into more than one online book. Use
online books when you want to print a document or when you want to search the whole
document.
You can print selected pages, a section, or the whole book. Cognos grants you a non-exclusive,
non-transferable license to use, copy, and reproduce the copyright materials, in printed or
electronic format, solely for the purpose of providing internal training on, operating, and
maintaining the Cognos software.
Online books are available from the introduction to the online help for each component.
You can also read the product readme files and the installation guides directly from Cognos
product CDs.
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Use Event Studio to notify decision-makers in your organization of events as they happen, so that
they can make timely and effective decisions.
You create agents that monitor your organization’s data to detect occurrences of business events.
An event is a situation that can affect the success of your business. An event is identified when
specific items in your data achieve significant values. Specify the event condition, or a change in
data, that is important to you. When an agent detects an event, it can perform tasks, such as
sending an email, adding information to the portal, and running reports.
For information about how to use Event Studio, see "Creating an Agent" (p. 21).
You can follow a tutorial that shows you how to create and run an agent in response to a business
scenario. For more information, see "Tutorial - Creating an Agent" (p. 39).

Source Items
Event Studio works with source items that were defined in a Framework Manager model and
published as a package to Cognos Connection. Source items are used to specify an event condition
that is monitored by the agent. You can also use source items to derive calculations or parameters
that may be included in the event condition.

The Event Studio Window
Use the Event Studio window to interactively create and manage agents.
The Event Studio window is made up of four areas:
• the I want to area
This area shows the main tasks that you perform when you create an agent.
• the Insertable Objects area
This area shows available source items, data items used by the current agent, functions you
can insert in the event condition, and parameters you created.
• the summary area
This area contains tabs with summary descriptions of the event condition and of each task
defined for the agent.
• the content area
This area contains the pages and dialogs that you use to create and manage an agent.
The four areas are shown in the following diagram.
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Insertable Objects Area
The Insertable Objects area contains items that you can add to the event condition and tasks.

The Source Tab
The source tab shows a hierarchical list of the source items, both relational and dimensional, in
the model package.

The Data Items Tab
The data items tab shows a list of all the data items contained in the agent. The data items tab also
shows the calculations used in the agent.

The Functions Tab
The functions tab shows a list of mathematical functions, such as operators and summaries, that
you can use in event conditions and to create calculated data items.
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Tip: If you are specifying an event condition and want to know the meaning of a function icon,
click the icon and read the description in the Information box.

The Parameters Tab
The parameters tab shows a list of each parameter you defined, indicated by the parameter icon.
You can use parameters when specifying the event condition.

Example - Create an Agent with a Single Task
You create an agent to perform a task when it detects a business event.
You are a sales manager who wants to ensure that your most valued customers are pleased with
the quality of service they receive.
You decide that, whenever a valued customer calls your support group, you will call the customer
the next day to make sure they’re satisfied. You use Event Studio to create an agent that monitors
support call records. You specify an event condition as follows:
[Call_Status]= Open AND [Customer_Profile]= Gold

Next you add a task and specify that, when the event occurs, the agent sends you an email entitled
Urgent: Call Customer Today!.
The email message you receive contains details both about the customer and about the call. You
do not need to continually check the call system or run reports. The relevant data is sent to you
only when you need to act upon it.

Events
An event is an exceptional item of data, defined by specifying a query expression against items in
a data package. When an agent runs, it checks the data for any event instances. When a record
matches the event condition, it causes an agent to perform tasks.
When an agent runs, it checks the data for any event instances.
For example you can specify an event condition as follows:
[Account_Balance] < 0

Event Instances
An event instance is a single row of data that matches the event query expression. When an agent
monitors data, it detects each event instance. The agent then follows the task execution rules
(p. 10) to determine if it should perform a task.
Some types of tasks are performed only once by the agent. Other types of tasks are repeated for
each event instance. For more information, see "Task Frequency" (p. 12).

Event List
An event list shows the events processed by the agent. Each event is categorized by one of the
following statuses:
• new
• ongoing but changed
• ongoing and unchanged
• ceased
When an agent runs, it derives the status by comparing the detected events with those detected in
the previous run. There is only one event list per agent, and it is updated each time the agent runs.
For each task in an agent, the event list is checked against the task execution rules (p. 10). The
task is performed for each event that conforms to the rules.
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Event Key
An event key is used to determine whether an event is new, ongoing but changed, ongoing and
unchanged, or ceased. Event Studio compares the event instances detected in each agent run with
those detected in the previous run. To ensure it correctly matches the event instances for
comparison, you must define an event key. The event key is the combination of data items that
uniquely defines an event instance.
For example, you are dealing with orders that were placed for out-of-stock goods. You define
Order Number as the event key, because each order placed has a unique number. If Order Number
1234 appears in this run and in the previous run, it is an ongoing event. If Order Number 4567
appears in this run, but not in the previous run, it is a new event. If Order Number 7890 appeared
in the last run but not this one, it has ceased.

Task Execution Rules
When an agent runs, it uses the event key (p. 10) to compare the event instances it detects with
those of the previous run. The agent allocates a status to each event - new, ongoing but changed,
ongoing and unchanged, or ceased. If no event instances are detected, the status is no events. The
task execution rules specify the event status for which each task is performed. If you do not set
any execution rules, the agent performs its tasks for all the event instances it detects.

Example - Event Status of New
You want to receive an email message advising you whenever a Gold category customer phones
technical support about a new problem.
You specify that an email task be performed only when the event status is new. You receive an
email when the call record from a Gold customer is first placed in the call database. However,
even if the call record is still open the next time the agent runs, you receive no further emails
because the status of the event is now ongoing.

Example - Event Status of Ongoing But Changed
You want a report to run if the account balance of an overdrawn customer changes.
You specify that a report task be performed only when the event status is ongoing but changed.

Example - Event Status of No Events
You want to receive a daily email that reassures you that none of your company’s accounts has a
balance less than zero.
You define the following event condition: [Account_Balance] < 0. You specify that an email
task be performed if the event status is no events.
In this example, you may also want to create another task that sends an urgent email if any of the
account balances does become less than zero. That is, you create another email task that is
performed if the event status is new.

Agents
Agents monitor data for instances of an event (p. 9) and perform tasks when events occur. These
tasks can help to notify people about events immediately, so that they can make timely and
effective decisions.
When an agent runs, it checks for occurrences of the event. If it detects the event, the agent
performs its tasks for events that meet the execution rules (p. 10). An agent runs its tasks either all
at the same time or in the order that you specify.

Example - Create an Agent with Multiple Tasks
You are a meteorological analyst who wants to be alerted about any sudden, extreme drops in air
pressure that could result in a violent storm.
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You create an agent named Pressure_Drop. You specify the event condition as follows:
[Air_Pressure].[Current_Time-60] - ([Air_Pressure].[Current_Time])>
5.0

Next, you add an email task and specify that, when the event occurs, the agent sends you an email
entitled Pressure Drop Alert. Finally, you add a report task that sends a report of the latest air
pressure readings to people in surrounding weather offices.

Prompting Agents
A prompting agent prompts a user to specify values for the event condition. This can result in the
task being performed in a situation that is specific to the user.
For example, you specify an event condition that prompts sales managers to specify their region
and their product. The task is then performed only for events that are of interest to the sales
manager who is running the agent.
The prompts of an agent can also be answered by passing in the values of source items from the
events of another agent.

Agent Views
You can use Cognos Connection to create an agent view. Agent Views are used to share the agent
specification. However you can run an agent view using different prompt values, if it is a
prompting agent, or following a different schedule.
For more information, see the Cognos Connection User Guide.

Tasks
An agent can perform one or more tasks that you define for it. You can use some tasks to notify
the right people quickly about a change in a business event so that they can take appropriate
action. Other tasks can help you to automate a work flow.
An agent can perform its tasks all in sequence or all in parallel. That is, you can specify that each
task is performed in the order you choose. Or you can specify that each task be performed at the
same time.
You can specify tasks that do the following:
• send an email (p. 23)
• publish a news item (p. 24)
• run a report (p. 25)
• run a job (p. 27)
• run an agent (p. 27)
• update a database (p. 28)
• call a Web service (p. 29)
• run an import (p. 30)
• run an export (p. 30)
• run a content maintenance task (p. 30)
• run a metric task (p. 31)
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Task Frequency
Before you specify an event condition, you should understand how often different types of tasks
are performed.
Task type

Number of times performed

Run a report; run an agent; run a job; run an
Once
import; run an export; run a metric task; run a
content maintenance task
Update a database; call a Web service

Once per event instance

Send an email

Variable
For more information, see "How Multiple
Events Affect Email Messages" (p. 13).

Publish a news item

Once

Notification Methods
If you want to notify people about a business event, you should understand the notification
methods that an agent can use. The notification that you choose should contain all information
relevant to the event and be seen by everyone who must know about the event.
An Event Studio agent can notify people about business events by
• delivering an email to your audience
• publishing a news item to a folder frequently viewed by your audience
An important part of a notification is its ability to contain dynamic information. This means that
source items from a package can be inserted into the message. The values for these items are not
retrieved until the agent is run because a notification message about a critical data item always
contains the current values.
Both email and news item notifications can contain dynamic information. In an email task, the
email can contain dynamic content in the list of recipients, the subject, and the message body. For
more information, see "Example - Add an Email Task" (p. 43).
The parts of a news item notification that can contain dynamic content are the headline, the
screen tip, and the text. For more information, see "Example - Add a News Item Task" (p. 45).
Although email and news item notifications can both show content dynamically, only email
notifications can change their target dynamically. By inserting email address items in the recipient
fields, you can specify that the recipient list change according to the data in the event list.

Email Notifications
You can notify people by email using either a report task or an email task. To help you decide
which method to use, you should understand how they differ.
You can use either a report task or an email task
• to send a single email text message
• to attach a single report in the specified output formats
If you attach only one HTML report and leave the body field empty, the report appears in the
message body.
• to add links to a single report for the specified output formats
For an email task but not a report task, you can also
• add dynamic content to the message, which may result in multiple emails
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•

•

This means that you can insert source items from a package into the message. If you insert an
email address item in the recipient fields, you can tailor the recipient list so that it is specific to
the data in the message.
send multiple reports in a single email as attachments and/or links
For example, you can attach a report about stock usage and a report on unfulfilled customer
orders when a particular stock item falls below a reorder level.
attach the event list

Emailing reports from an Event Studio agent is useful if you want the report to be tailored to a
specific event. However, if you want to regularly send a report by email that is not related to an
event, you do not need to create an agent. You can send it by email from Cognos Connection. For
more information, see the Cognos Connection User Guide.

News Item Notifications
A news item task publishes a headline to a folder whose contents can be viewed in a Cognos
Navigator portlet and in any folder view. When someone clicks on a headline, they can open
Cognos 8 content or view a Web page.

How Multiple Events Affect Email Messages
When you create an email message, you can drag data items into the message body. These data
items act as placeholders. When the agent runs, the placeholders are replaced with actual values
from the data source.
If the agent detects several events that satisfy the event condition, the size of the message body in
the delivered email can increase. Every line in the message body that contains a data item
placeholder is repeated for each event instance that satisfies the task execution rules.
For information about how multiple events affect email messages, see "Example - Add an Email
Task" (p. 43).
If data items appear only in the message body, a single message is usually sent containing details of
all the events detected. However, if the address or subject fields include data items, many emails
may be sent.

Dynamic Address
For some messages, the appropriate recipient depends on the values in the event. For example, a
message about a support call from Customer A must be addressed to Customer A's account
manager.
If the data source includes an item that represents email addresses, you can drag this item to the
recipient fields. The agent uses this data to generate the email address dynamically. If the agent
detects several events that satisfy the event condition, it generates one message for each email
address. The source items in the message body are grouped by address.

Dynamic Subject
If you include a source item in the subject field, the agent generates one message for each subject.
The source items in the message body are grouped by subject.

Dynamic Address and Dynamic Subject
If you include source items in both the address and subject fields, the messages are grouped by
address and subject.

Samples
Cognos 8 includes report samples and an agent sample. When installed, you can find them in the
Public Folders tab in Cognos Connection.
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The Retailer Contact (Multiple Prompt Values) Sample
This report sample is used in a tutorial in this document. For more information, see "Tutorial Creating an Agent" (p. 39).
The Retailer Contact (Multiple Prompt Values) report is a list report that can accept more than
one prompt value. When included in a report task using Event studio, this report can accept
multiple data source values as prompts if the agent detects more than one event instance.

The Returns Agent Sample
This agent sample was created using the Event Studio example illustrated in Cognos 8 Getting
Started. If you try this example yourself, you can compare the agent that you create with the
Returns Agent sample.
The Returns Agent sample notifies you when a customer returns a product because it was
defective, unsatisfactory, or incomplete, or because the wrong product was shipped.

The ELM Returns Agent Sample
This agent sample is used in the topic "Example - Managing the Life Cycle of an Event" (p. 14).
The ELM Returns Agent sample notifies you when a customer returns a product because it was
defective, unsatisfactory, or incomplete, or because the wrong product was shipped. Two days
after detecting the event, this agents checks if the issue is resolved. If unresolved event instances
still exist, it runs the ELM Escalation Agent sample.

The ELM Escalation Agent Sample
This agent sample is used in the topic "Example - Managing the Life Cycle of an Event" (p. 14).
The ELM Escalation Agent sample is run by the ELM Returns Agent sample. If more than two
days have lapsed since the ELM Returns Agent sample detected an event, the ELM Escalation
Agent sample escalates the issue by sending an email to the customer fulfillment manager.

Example - Managing the Life Cycle of an Event
Try this example to see how the ELM Returns Agent sample performs different tasks depending
on the stage of the life cycle for the event.
Event Life cycle Management (ELM) is the ability to identify, track, and take appropriate action
on an event at the right time and in the right sequence. Different information, people, and tasks
are required at different stages in the life cycle of an event.
You are the customer fulfillment manager at the Great Outdoors company. After analyzing data
warehouse metrics, you determine that when orders are returned for reasons that the Great
Outdoors company can control, there is a significant impact on customer loyalty. Customers
withhold payment for the entire order until the issue is resolved.
To identify these issues and resolve them as quickly as possible, you decide to run the ELM
Returns Agent sample. To run this agent, do the following:
❑ Perform setup tasks that are necessary only to demonstrate this example. These tasks are as
follows.
• Configure your mail server so that Cognos 8 can send notifications (p. 15).
• Modify the agent samples to send emails to you (p. 15).
• Simulate the occurrence of initial events (p. 16).
• Simulate the passage of time and the resolution of some events (p. 17).
❑ Preview the output of all agent tasks (p. 16).

❑ Detect initial events and act on them as necessary (p. 16).
❑ Detect an ongoing, unresolved event and escalate the issue (p. 18).
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❑ Confirm that the ELM Escalation Agent sample completed all its tasks successfully (p. 18)

Example - Configure Your Mail Server
Configure your Cognos 8 mail server to send notifications using Event Studio or Cognos
Connection.

Steps
1. Start Cognos Configuration.
2. In the Explorer pane, click Notification.
3. Enter the notification properties:
• In the SMTP mail server box, type a mail server that is appropriate for your environment.
• In the Account and Password box, type your email user ID and password.
• In the Default sender box, type the following:
notifications@cognos8
4. Save the configuration.
The next step in the managing the life cycle of an event example is to modify the agent samples to
send emails to you.

Example - Modify the Agent Samples to Send Emails to You
The agent samples named ELM Returns Agent and ELM Escalation Agent are set up to send
emails to other people. To view the emails that these other people would normally receive, change
the recipient email address to your own email address.

Steps for the ELM Returns Agent Sample
1. Start Cognos Connection.
2. Click GO Events.
3. Click ELM Returns Agent.
Event Studio starts, and the ELM Returns Agent sample appears.
4. In the upper-right corner of the window, click the Follow up required email task.
5. In the Specify the email to send window, in the To box, replace
salesrepresentative@yourcompany.com with your own email address.
6. From the File menu, click Save.
7. From the File menu, click Exit.
The destination address is changed to your email address so that the agent sends emails to you.
The sender address remains notifications@cognos8.

Steps for the ELM Escalation Agent Sample
1. In Cognos Connection, click ELM Escalation Agent.
Event Studio starts, and the ELM Escalation Agent sample appears.
2. Near the top of the window, click the Outstanding Returned Item Order email task.
3. In the Specify the email to send window, in the To box, replace
FulfilmentManager@yourcompany.com with your own email address.
4. From the File menu, click Save.
5. From the File menu, click Exit.
The destination address is changed to your email address so that the agent sends emails to you.
The sender address remains notifications@cognos8.
The next step in the managing the life cycle of an event example is to simulate the occurrence of
initial events.
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Example - Simulate the Occurrence of Initial Events
Run part of the Event_Studio_ELM_Agent_Modify_GOSL.sql script to simulate the following
data changes:
• change the date to the current date
•
change the follow-up code to -1 in four records.
A code of -1 indicates that follow-up is required.

Steps
1. In SQL Query Analyzer, from the File menu, click Open.
2. Go to c8_location/webcontent/samples/datasources/sqlserver and double-click the
Event_Studio_ELM_Agent_Modify_GOSL.sql file.
3. In the toolbar, from the list of databases, click GOSL.
4. In the Query window, under Part 1, select all sixteen lines of code.
5. From the Query menu, click Execute.
The database is updated with the changes.
The next step in the managing the life cycle of an event example is to preview the output of each
task of an agent.

Example - Preview the Output of Each Task of an Agent
You can preview the output of the ELM Returns Agent sample based on the current data, without
running the agent.

Steps
1. In Cognos Connection, click ELM Returns Agent.
Event Studio starts, and the ELM Returns Agent appears.
2. From the Actions menu, click Preview All.
A window appears that shows the event list and the output that would be produced by each agent
task. Based on this preview information, you can decide whether to run the agent.
The next step in the managing the life cycle of an event example is to detect initial events and act
on them.

Example - Detect Initial Events and Act on Them
Run the ELM Returns Agent to detect the initial instances of products returned for specific
reasons. When these events are detected, the ELM Returns Agent does the following:
• It runs the AssignStaff stored procedure.
AssignStaff provides details about the sales representatives associated with each event
instance, including the email address.
• It sends an email to the appropriate sales representatives, advising them to contact their
customer.
• It runs the ELM Escalation Agent.
The ELM Escalation Agent checks for returned product events flagged by the ELM Returns
Agent. If one of these events still exists after two days, the ELM Escalation Agent sends an
email to the customer fulfillment manager.

Steps
1. In Cognos Connection, click Public Folders, and then click GO Events.
2. Click the run with options button on the actions toolbar next to the ELM Returns Agent
sample.
3. Under Time, click Now.
4. Under Prompt Values, clear the Prompt for values check box.
5. Click Run.
16
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6. Click OK twice.
You receive two emails, originally intended for sales representatives Karen Bowman and Clarice
Oliveira. The email to Karen Bowman notifies her of one returned order. The email to Clarice
Oliveira notifies her of the three returned orders assigned to her, as shown in the following
diagram.

The task execution rules for the ELM Returns Agent sample specify that all tasks are performed
for new events only. If you do not receive any emails, the agent may already have run, so that none
of the detected events are new. You can reset the event list so that when the agent runs next, all
detected events have a status of new.
Tip: From the Actions menu, click Reset Event List.
The next step in the managing the life cycle of an event example is to simulate the passage of time
and the resolution of some events.

Example - Simulate the Passage of Time and the Resolution of Some Events
Run part of the Event_Studio_ELM_Agent_Modify_GOSL.sql script to simulate data changes.
First, change it so that two days elapsed since the ELM Returns Agent sample was last run.
Second, for three of the four event instances found the last time that the ELM Returns Agent
sample ran, change the follow-up code from -1 to +1. This indicates that only one of the these
event instances still requires follow-up and the other instances are resolved.

Steps
1. In SQL Query Analyzer, from the File menu, click Open.
2. Go to c8_location/webcontent/samples/datasources/sqlserver and double-click the
Event_Studio_ELM_Agent_Modify_GOSL.sql file.
3. On the toolbar, click GOSL from the list of databases.
4. In the Query window, under Part 2, select all lines of code that appear after the comments.
5. From the Query menu, click Execute.
The database is updated with the changes.
The next step in the managing the life cycle of an event example is to detect an ongoing unresolved
event and escalate the issue.
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Example - Detect an Ongoing Unresolved Event and Escalate the Issue
Run the ELM Returns Agent sample a second time. The agent now detects only one event because
you modified the followup codes in the previous task (p. 17). In addition, because two days lapsed
since the sales representative was notified, the event condition of the ELM Escalation Agent
sample is met. The ELM Escalation Agent sample detects the event and sends an email to the
customer fulfillment manager.

Steps
1. In Cognos Connection, click Public Folders, then click GO Events.
2. On the actions toolbar, click the run with options button next to the ELM Returns Agent
sample.
3. Under Time, click Now.
4. Under Prompt Values, clear the Prompt for values check box.
5. Click Run.
6. Click OK twice.
After this agent runs, you receive only one email. Instead of being sent to the sales representative,
this email is escalated to the customer fulfillment manager, as shown in the following diagram.

The next step in the managing the life cycle of an event example is to confirm that the ELM
Escalation Agent sample completed its tasks successfully.

Example - Confirm that the ELM Escalation Agent Sample Completed Its Tasks
Successfully
Using Cognos Connection, you can confirm that the ELM Escalation Agent sample, which is run
by the ELM Returns Agent sample, completed its tasks successfully.

Steps
1. In Cognos Connection, click Public Folders, and then click GO Events.
2. On the actions toolbar next to the ELM Escalation Agent sample, click More.
3. Click View run history.
4. In the Actions column, click the view run history details button.
A window appears showing that the event query and email task succeeded, as shown in the
following diagram.
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Create an agent to monitor data for instances of an event and to perform tasks.
Before you create an agent, you should understand the notification methods that an agent can use
(p. 12). You should also know how often an agent performs different types of tasks (p. 12).
To create an agent, do the following:
❑ Specify the event condition(p. 21).

❑ Add one or more of the following types of tasks for the agent to perform when the event
status meets the task execution rules:
• email task (p. 23)
• news item task (p. 24)
• report task (p. 25)
• job task (p. 27)
• agent task (p. 27)
• database update task (p. 28)
• Web service task (p. 29)
• export task (p. 30)
• import task (p. 30)
• content maintenance task (p. 30)
• metric task (p. 31)
❑ Specify the task execution rules (p. 31).

After you create an agent, you can preview it (p. 32), test it (p. 35), run it (p. 36), or work with it
in Cognos Connection (p. 36). You can also modify the event condition (p. 34), modify a task
(p. 35), or modify the task execution rules (p. 35).

Specify an Event Condition
When you specify an event condition, you describe a specific occurrence of data items that an
agent must detect before it performs its tasks. The event condition is a query expression that you
create using items from the package.
For more information, see "Example - Specify an Event Condition" (p. 41).
If you want to include parameters (p. 22) or calculations (p. 22) in the event condition, you must
create them before you define the event.

Steps
1. From the Actions menu, click Specify Event Condition.
2. Create a detail expression, a summary expression, or both.
• If you want part of the event condition to apply to values of individual source items, click
the Detail tab and follow step 3.
• If you want part of the event condition to apply to aggregate values, click the Summary
tab and follow step 3.
3. In the Expression box, create a query expression:
• Drag items from the source tab or type text directly.
• Drag operators, summaries, and other mathematical functions from the functions tab or
type text directly.
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Tip: To see the meaning of an icon on the functions tab, click the icon and read the
description in the Information box.
• If you want to insert a parameter (p. 22), drag it from the parameters tab.
• If you want to insert a calculation (p. 22), drag it from the data items tab.
• Insert values, if required.
Tip: To select from a list of possible values for the selected item, click the select value
button. Move the values you want from the Select Value box to the Selected Items box
and click OK.
For example, you can type the following expression:
[Unit price] * [Quantity sold]> 5000

4. If you want to check the event list to ensure that you specified the event condition correctly,
from the Actions menu, click Preview.
5. If you want to know how many event instances there are, from the Actions menu, click Count
Events.
6. From the File menu, click Save As.
7. Specify a name and location for the agent and click OK.
You can preview the event list returned by the event condition. For more information, see
"Preview the Data" (p. 32).

Define a Parameter
You can define a parameter and include it in an event condition. When the agent runs, it prompts
the user to enter a value for the parameter. You can also use parameters to accept the results of a
previous agent.
For more information, see "Example - Define a Parameter" (p. 40).

Steps
1. From the Insert menu, click Parameter.
2. In the Parameter name box, type a name for the parameter.
3. If you want the parameter to have multiple values, select the Accept multiple values check
box.
4. Click OK.
The parameter appears in the data items tab.
You can include the parameter when you specify an event condition "Example - Define a
Parameter" (p. 40).

Define a Calculation
A calculation is a query expression that defines an arithmetic combination of data items. For
example, you can define a calculation named Product Sales that is the product of the unit price
and the quantity sold.
For more information, see "Example - Define a Calculation" (p. 40).

Steps
1. From the Insert menu, click Calculation.
2. In the Name box, type a name for the calculation.
3. In the Expression box, define the calculation:
• Drag items from the source tab or type text directly.
Tip: If you type the text, you must include the full path of each data item. For example,
you can type the following expression:
[gosales_goretailers].[Orders].[Unit price] *
[gosales_goretailers].[Orders].[Quantity]
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Drag operators, summaries, and other mathematical functions from the functions tab or
type text directly.
Tip: To see the meaning of an icon on the functions tab, click the icon and read the
description in the Information box.
• Insert values, if required.
Tip: To select from a list of possible values for the selected item, click the select value
button. Move the values you want from the Select Value box to the Selected Items box
and click OK.
4. Click OK.
The calculation icon appears in the data items tab.
You can include the calculation when you specify an event condition (p. 21) or specify a task.

Adding Tasks
You can add multiple tasks to an agent. However, you can specify only one event condition (p. 21)
per agent. Each task is performed for the event list that meets the execution rules you specify for
the task (p. 31). The agent performs tasks in the order that you add them, unless you change their
order later (p. 34). You can save an agent (p. 46) and add additional tasks to it later.

Previous Function
You can add source items (p. 8) or data items (p. 8) to some types of tasks. When the agent
performs the task, it uses the current value of the item. If you want the agent to use the value that
a particular item had the previous time the agent ran, you can insert the previous function before
the item.
To insert the previous function, from the Insert menu, click Previous Value.

Add an Email Task
Add an email task to an agent to send an email about an important business event. Email tasks
provide you with the flexibility to send an email with the content you want to the recipients you
want.
For more information, see "Example - Add an Email Task" (p. 43).
You can also add other types of tasks (p. 11). Email tasks share some similarities with report
tasks. For more information, see "Email Notifications" (p. 12).
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In the I want to area, click Add a task.
2. Click Email.
3. In the To box, and if applicable, the Cc or Bcc boxes, enter the email addresses of the
recipients using one or more of the following methods:
• You can type text directly, separating each email address using a semicolon.
• If your model contains a data item that is an email address, you can drag this item from
the source tab or from the data items tab. When the agent runs, the data item for each
event instance is replaced by the current value in the package.
• You can click select the recipients, find the users, groups, roles, contacts and distribution
lists, select the entries you want, click the arrow button to update the Selected entries list
and click OK.
4. In the Subject box, type the subject of the email.
Tip: You can also drag items from the source tab or from the data items tab. When the agent
runs, the data item for each event instance is replaced by the current value in the package.
5. In the Body box, type the email message text directly or drag items from the source tab or
from the data items tab.
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6.

7.

8.
9.

10.

If you insert data items in the Body box, the body message will be longer. When the agent
runs, the data item for each event instance is replaced by the current value in the package. For
more information, see "How Multiple Events Affect Email Messages" (p. 13).
If the email has a single HTML attachment and the Body box is empty, the attachment
appears inline.
If you want, change the message format from HTML to plain text or vice versa:
• To change from the default HTML format to plain text format, click the Plain text link.
Tip: After you switch to plain text format, any HTML formatting changes are lost.
• To change from plain text to HTML, click the HTML format link. You can then use
formatting buttons to edit the message.
If you want to add attachments, click Attach and choose the attachments you want:
• To attach the event list, click Attach the event list.
• For any report task that has the Enable attachment of the report in email tasks check box
selected, click Attach the reportreport name.
Tip: For more information about enabling a report as an email attachment, see
"Customize the Report" (p. 26).
If you want to add links, click Add links, select the entries you want, click the arrow button to
update the Selected entries list and click OK.
Under Send this email for the events, review the event status that will cause the email to be
sent.
Tip: If you want to change this event status, you can edit the task execution rules (p. 35).
From the File menu, click Save.

You can preview the email task (p. 32). When the agent runs, it retrieves values for all source and
data items and sends the email to the recipients you chose.

Add a News Item Task
Add a news item task to an agent to publish a headline to a folder in Cognos Connection.
For more information, see "Example - Add a News Item Task" (p. 45).
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In Cognos Connection, create a new folder or portlet.
For more information, see the Cognos Connection User Guide.
2. In Event Studio, specify an event condition (p. 21).
3. In the I want to area, click Add a task.
4. Click News Item.
5. In the Headline box, type the text you want to appear as your news item headline.
Tip: You can also drag items from the source tab or the data items tab.
6. If you want, in the Screen tip box and in the Text box, you can type a description of the entry.
The screen tip is limited to 100 characters.
Tip: You can also drag items from the source tab or from the data items tab.
7. Under Link to, choose an object that you want to appear when you click a news headline.
• To link to Cognos 8 content, click Select an entry, go to the entry you want, and click
OK. For example, if you want the Retailer Contact report to appear when someone clicks
the headline, click Select an entry, locate the Retailer Contact report and click OK.
Tip: You can add a report task that runs a report before the news item task is performed.
If you link that report to the news item task, the report always shows information about
current event instances when someone clicks the headline.
• To link to a URL, type the URL address in the box shown.
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If the URL points to a Web site address, the protocol, such as http, must be included. For
example, to create a URL for the Cognos Web site, you would type
http://www.cognos.com.
8. Under News list location, click Select a location, go to the folder or portlet in which the news
item will be published and click OK.
9. Under Publish this news item for the events, review the event status that will cause the news
item to be published.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
10. From the File menu, click Save.
You can preview the news item task (p. 32). When the agent performs the news item task, it
publishes the news headline to the location you chose. When you click the headline, the Cognos 8
entry or the Web page you linked to appears.
The description text appears when you set your Cognos Connection preferences to use the details
view. The screen tip appears when you pause your pointer over the icon for the entry in the news
list location.

Add a Report Task
Add a report task to an agent to run a report that is related to an important business event.
For more information, see "Example - Add a Report Task" (p. 42).
You can also add other types of tasks (p. 11). Email tasks share some similarities with report
tasks. For more information, see "Email Notifications" (p. 12).
Before you add any type of task, you must specify an event condition (p. 21).
You must have permissions to run the report that you select. For more information, see the Report
Studio User Guide.

Steps
1. In the I want to area, click Add a task.
2. Click Report.
3. In the Select the Report dialog box, specify the report, query, analysis, or report view to
include in the agent.
• Search the folders to find the entry you want.
• Click the entry and click OK.
4. If you want, under Options, click Set and customize the report (p. 26).
5. If the report includes parameters, under Prompt values, choose how to specify prompt values
for each parameter:
• If you are using an item, in the Method column, click Use an item and drag an item from
the source tab or from the data items tab to the Value column.
Tip: When you specify a data item, values from the event list are passed as prompt values
in the report. If the event list has multiple instances, then multiple values are passed as
prompt values. Therefore you must ensure that the report being run has a prompt that
can accept multiple values. For more information, see the Report Studio User Guide.
• If you are using a value, in the Method column, click Use a value, click Specify values,
and in the Value column, type a value.
Tip: If you want to clear the prompt values and return to the default values, click Reset to
default.
6. Under Run this report for the events, review the event status that will cause the report to run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
7. From the File menu, click Save.
You can preview the report task (p. 32). When the agent performs the report task, it runs the
report and delivers it according to the delivery options you chose (p. 26).

User Guide 25

Chapter 2: Creating an Agent

Customize the Report
Change the report options from the default options to customize the report for your audience.
You can do the following:
• Change one or more report output formats.
• Change one or more languages.
• Change one or more delivery methods.
• Burst the report if it was authored with bursting specifications.
Default options are set by the report author. You can change some default run options for reports.
You change the report options when you click Set or Edit in the Specify the report to run dialog
box. For more information, see "Add a Report Task" (p. 25).
Setting the report options for a report task in Event Studio is similar to running a report with
options in Cognos Connection. For more information, see the Cognos Connection User Guide.

Steps
1. In the Select the report options dialog box, under Formats, click the formats you want for the
report output.
2. If you want to select different or additional languages for the report, click Select the languages
and use the arrow keys to move the available languages to the Selected languages box and
click OK.
Tip: To select multiple languages, press Ctrl + click or Shift + click.
3. Under Delivery, choose the delivery method that you want:
• To print the report, click Select a printer. Click the button next to the printer you want to
use and click OK. Or, if the printer is not listed, you can type the printer information.
Tip: If you have administrator privileges and want to set up the printer for future use,
click New printer. You must type the network address of the printer by using the format
\\server_name\printer_name for a network printer on a Windows installation and
printer_name for a UNIX installation or for a local printer.
• To save the report as a report view, you can change the name or target folder of the report
view. Click Edit the save as options, make the changes, and click OK.
Tip: Save the report as a report view if you do not have write access to the report. You
can then add a link to the report view when you specify an email task.
• To attach the report in an email task that you create later, you must select the Enable
attachment of the report in email tasks check box.
• To email the report, click Send the report by email.
4. If you clicked Send the report by email, click Edit the email options and specify what you
want:
• If you want to send the email to Cognos 8 recipients, click Select the recipients. Select the
check box next to the names you want to include, and click To, Cc (copy), or Bcc (blind
copy). The entries that you select are listed under Selected entries. Click OK.
Tip: To select all entries in a list, click the check box in the upper-left corner of the list. To
remove names from Selected entries, select the check box next to the name and click
Remove. To search, click Search. In the Search string box, type the phrase you want to
search for. For advanced search features, click Edit.
• If you want to send the email to other recipients, in the To:, Cc, or Bcc boxes, type the
email addresses separated by semicolons (;).
Tip: If you logged on, your name automatically appears in the To list box.
• Under Subject, type the subject of the email.
• Under Body, type a message to be included in the email.
• If you want to include an attachment, select the check box to include the report or a link
to the report, and click OK.
If you are an administrator, you can prevent users from including attachments. For more
information, see the Cognos 8 Administration and Security Guide.
5. Under Bursting, specify whether the report should be bursted.
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This option is available only if the report author defined burst keys in the report.
6. Click OK.
The Specify the report to run dialog box appears.
7. Continue specifying the report. For more information, see "Add a Report Task" (p. 25).

Add a Job Task
Add a job task to an agent to run a job. A job identifies a collection of reports, report views,
agents, and other jobs that are scheduled together and share the same schedule settings. For more
information, see the Cognos Connection User Guide.
For example, in Cognos Connection, you create a job named Two Reports, and select two reports
that you want the job to run. In Event Studio, you add a job task and select the Two Reports job.
When the agent runs and detects events that meet the task execution rules, it runs the Two Reports
job.
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).
Before you create a job task, you must create a job in Cognos Connection. For more information,
see the Cognos Connection User Guide.

Steps
1. In the I want to area, click Add a task.
2. Click Job.
3. In the Select the job dialog box, specify the job to include in the agent.
• Search the folders to find the job you want.
• Click the entry and click OK.
4. Under Run this job for the events, review the event status that will cause the job to run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
5. From the File menu, click Save.
You can preview the job task (p. 32). When the agent performs the job task, it runs all the
Cognos 8 items identified in the job.

Add an Agent Task
Add an agent task to an agent to run another agent. By running multiple agents in sequence, you
can use the output from one agent as the input to another agent. You can also use multiple agents
that interact with each other using data retrieved from different data sources. This removes the
need to join databases using Framework Manager.
For more information, see "Example - Adding an Agent Task" (p. 28).
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In the I want to area, click Add a task.
2. Click Agent.
3. In the Select the agent dialog box, choose an agent.
• Search the folders to find the agent you want.
• Click the entry and click OK.
4. If the task includes parameters, under Prompt values, choose how to specify prompt values for
each parameter:
• If you are using a value, in the Method column, click Use a value, click Specify values,
and in the Value column, type a value.
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If you are using an item, in the Method column, click Use an item and drag an item from
the source tab or from the data items tab to the Value column.
Tip: If you want to clear the prompt values and return to the default values, click Reset to
default.
5. Under Run this agent for the events, review the event status that will cause the agent to be run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
6. From the File menu, click Save.
You can preview the agent task (p. 32). When the agent performs the agent task, it runs the agent
you specified.

Example - Adding an Agent Task
You want to run the high_returns_followup agent to detect a high rate of returned items and
resolve the related issue. However, for each item that has a high rate of return, you also want to
check the importance of the customer to your company as calculated from data in a data
warehouse system. The customer’s importance value is calculated using projected sales and profit
data.
You create a second agent named high_returns_customer_check that is run by the
high_returns_followup agent. When a high return event occurs, the high_returns_followup agent
runs and passes customer details to the high_returns_customer_check agent. The
high_returns_customer_check agent then runs a query to check the customer importance value. If
the customer importance value is high, the high_returns_customer_check agent sends an email
asking the customer services agent to contact the customer and fix the problem immediately.

Add a Database Update Task
Add a database update task to an agent to run stored procedures that exist in a database. A stored
procedure takes arguments as input and updates the database. The database that contains the
stored procedures can be different from the database in the package that the agent is monitoring.
For information about running stored procedures, see the Administration and Security Guide.
You can also add other types of tasks (p. 11).
A stored procedure is accessible in Event Studio only if it was marked as a data modification type
in Framework Manager. For more information, see the Framework Manager User Guide.
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1.
2.
3.
4.

In the I want to area, click Add a task.
Click Database Update.
Under Package, click the package you want to use to update the database.
Under Data modification stored procedure, click a stored procedure that exists for the
package you selected.
5. If the stored procedure includes arguments, under Arguments, choose how to specify values
for each argument:
• If you are using a value, in the Method column, click Use a value, click Specify values,
and in the Value column, type a value.
• If you are using an item, in the Method column, click Use an item and drag an item from
the source tab or from the data items tab to the Value column.
Tip: If you want to clear the argument values and return to the default values, click Reset to
default.
6. Under Update the database for the events, review the event status that will cause the stored
procedures to run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
7. From the File menu, click Save.
You can preview the database update task (p. 32). When the agent performs the database update
task, the stored procedures are run and the database is updated.
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Add a Web Service Task
Add a Web service task to an agent to call a Web service. Web services are software programs that
interact with one another using standard Internet protocols.
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).
Before you create a Web service task, you must ensure that a valid Web Services Description
Language (WSDL) specification exists. You also must find out what the required inputs are to the
Web service and what its outputs will be.

Steps
1. In the I want to area, click Add a task.
2. Click Web Service.
3. In the Web service URL box, type the URL of the Web service.
If the URL points to a Web site address, the protocol, such as http, must be included.
4. Click Retrieve.
The available method and the list of arguments is retrieved.
5. Under Operation, click the Web service operation you want to perform.
6. If the operation includes arguments, under Arguments, choose how to specify values for each
argument:
• If you are using a value, in the Method column, click Use a value, click Specify values,
and in the Value column, type a value.
• If you are using an item, in the Method column, click Use an item and drag an item from
the source tab or from the data items tab to the Value column.
Tip: If you want to clear the argument values and return to the default values, click Reset to
default.
7. Under Call the Web Service for the events, review the event status that will cause the Web
service to be called.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
8. From the File menu, click Save.
You can preview the Web service task (p. 32). When the agent performs the Web service task, the
Web service is called and its service is run.

Example - Adding a Web Service Task
You want to notify customer service representatives and suppliers about orders that have a high
rate of return. You could do this by adding an email task. For more information, see "Example Add an Email Task" (p. 43). However, you know that some of the service representatives and
suppliers do not have access to email. You also know that they all closely monitor the Customer
Relationship Management (CRM) system.
You decide to notify the service representatives and suppliers by creating records in the CRM
system. Each record is linked to a customer name and to the type of product that was returned.
Your company developed a Web service that creates CRM records. In Event Studio, you add a
Web service task that calls your company’s Web Service.
When the agent performs the Web Service task, the Web service updates the profile of customers
who returned products. An updated customer profile can improve your sales performance in two
ways:
• It helps the services representative to contact the customer quickly to resolve the current
problem.
• It helps the supplier ensure that they don’t make the mistake of supplying a particular product
to that customer again.

User Guide 29

Chapter 2: Creating an Agent

Add an Export Task
Add an export task to an agent to export entries to a deployment archive. The export is defined in
Cognos Connection. For more information, see the Cognos 8 Administration and Security Guide.
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In the I want to area, click Add a task.
2. Click Export.
3. In the Select the export dialog box, specify the export to include in the agent.
• Search the folders to find the export you want.
• Click the entry and click OK.
4. Under Run the export for the events, review the event status that will cause the export to run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
5. From the File menu, click Save.
You can preview the export task (p. 32).

Add an Import Task
Add an import task to an agent to import entries from a deployment archive to your target
environment. The import is defined in Cognos Connection. For more information, see the
Cognos 8 Administration and Security Guide.
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In the I want to area, click Add a task.
2. Click Import.
3. In the Select the import dialog box, specify the import to include in the agent.
• Search the folders to find the import you want.
• Click the entry and click OK.
4. Under Run the import for the events, review the event status that will cause the import to run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
5. From the File menu, click Save.
You can preview the import task (p. 32).

Add a Content Maintenance Task
Add a content maintenance task to an agent to run a content maintenance task created in Cognos
Connection. A content maintenance task searches the content store for user information that no
longer exists in your external namespaces. It can also fix the content store by deleting any users
that do not exist in your external namespaces. For more information, see the Cognos 8
Administration and Security Guide.
You can also add other types of tasks (p. 11).
Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In the I want to area, click Add a task.
2. Click Content Maintenance Task.
3. In the Select the content maintenance task dialog box, specify the content maintenance task to
include in the agent.
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• Search the folders to find the content maintenance task you want.
• Click the entry and click OK.
4. Under Run the content maintenance task for the events, review the event status that will cause
the content maintenance task to run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
5. Under Mode, choose whether to find, or find and fix problems:
• To find user information that no longer exists in your external namespaces, click Find
only.
• To find and delete from the content store any users that do not exist in your external
namespaces, click Find and fix.
6. From the File menu, click Save.
You can preview the content maintenance task (p. 32).

Add a Metric Task
Add a metric task to an agent to run tasks available in a metric package. For example, you can
clear metric history data from the data store. Or you can import data from files into a staging
area. For more information, see the Metric Studio User Guide.
You can also add other types of tasks (p. 11).
Before you can open a metric package, you must install Cognos 8 Metrics Manager. For more
information, see the Cognos 8 Metrics Manager Quick Start Installation and Configuration
Guide. Before you add any type of task, you must specify an event condition (p. 21).

Steps
1. In the I want to area, click Add a task.
2. Click Metric Task.
3. In the Select the metric task dialog box, specify the metric task to include in the agent.
• Search the folders to find the metric task you want.
• Click the entry and click OK.
4. Under Run the metric task for the events, review the event status that will cause the metric
task to be run.
Tip: If you want to change this event status, you can modify the task execution rules (p. 35).
5. From the File menu, click Save.
You can preview the metric task (p. 32).

Specify the Task Execution Rules
Task execution rules specify when a task is performed. By default, a task is performed for new
instances of events and all ongoing instances of events, but you can change this.
For more information, see "Example - Change the Task Execution Rules for a Report
Task" (p. 43) or "Example - Change the Task Execution Rules for an Email Task" (p. 44).
You specify the task execution rules separately for each task in the agent.
Before you specify the task execution rules, you must add one or more tasks (p. 23).

Steps
1. In the I want to area, click Manage the task execution rules.
2. On the source tab, click one or more data items that uniquely define an event and drag it to
the Specify the event key box.
For example, click Order Number, because no two event instances can have the same order
number.
The event key is defined for all tasks in the agent.
3. Click Next.
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4. On the Select when to perform each task page, do the following:
• In the Tasks box, click the task that the agent will perform for the event statuses you
specify.
• Under Perform the selected task for, select one or more event status values.
5. If you want to manage the execution rules for another task, repeat step 4.
6. Click Finish.
The execution rules for each task you selected are set.
Tip: If you want to reset the execution rules for every task in the agent to the default values,
from the Actions menu, click Remove Task Execution Rules. Each task is reset to be
performed for new instances of events and all ongoing instances of events.
7. Save the agent.

Preview the Data
You can see the list of events detected when the event definition is applied to the current data. You
can also see preview information about each task in your agent.
For example, you are an administrator and want to preview the event list and all the tasks before
you make the agent available for other people to use.
The preview information for each type of agent item is described in the following table.
Agent item

Preview information

The event list

A table appears with columns for each data item contained in the
event condition. For each event instance, a row appears that
shows the value of each data item.

Email task

Representations appear of all emails that would be sent using the
default task execution rules. Data items in the recipient, subject,
and body fields are replaced by values from the source data.

News item task

A representation appears of the news item that would be created
using the default task execution rules. Data items in the recipient,
subject, and body fields are replaced by values from the source
data.

Report task

If the report accepts prompt values, a table appears with columns
for each parameter. For each event instance, a row appears that
contains the prompt values.
If the report does not accept prompt values, a sentence appears
telling you that the report will run once.

Job task

A sentence appears telling you that the task will run once.

Import task
Export task
Content maintenance task
Metric task
Agent task

If the agent accepts prompt values, a table appears with columns
for each parameter. For each event instance, a row appears that
contains the prompt values.
If the agent does not accept prompt values, a sentence appears
telling you that the agent will run once.
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Agent item

Preview information

Database update task

If the stored procedure accepts arguments, a table appears with
columns for each argument. For each event instance, a row
appears that contains the argument values.
If the stored procedure does not accept arguments, a sentence
appears telling you that the stored procedure will run once.

Web service task

If the Web service accepts arguments, a table appears with
columns for each argument. For each event instance, a row
appears that contains the argument values.
If the Web service does not accept arguments, a sentence appears
telling you that the Web service will run once.

Items shown on the preview pages show data for every event instance in the event list. If you
change the task execution rules, the preview data remain the same. For more information, see
"Specify the Task Execution Rules" (p. 31).
Before you can preview data, you must define an event condition (p. 21).
To preview the data, do the following:
• From the Actions menu, click Preview All or Preview.
The Preview All report begins with a table of contents that contains links to the preview
information for each agent item. The Preview report shows preview information for the agent item
on the current page.

Create a Schedule for an Agent
By scheduling an agent to run at regular intervals, you do not have to manually run the agent. The
agent monitors data and performs tasks to ensure that problems are dealt with as soon as possible.
You use Cognos Connection to schedule an agent the same way that you schedule other Cognos 8
items. For more information, see the Cognos Connection User Guide.
Only one schedule can be associated with each agent. If you require multiple schedules for an
agent, create agent views and then create a schedule for each view.

Steps
1.
2.
3.
4.

In the I want to area, click Schedule the agent.
Under Frequency, select how often you want the schedule to run.
Under Start, select the date and time when you want the schedule to start.
Under End, select when you want the schedule to end.
Tip: If you want to create the schedule but not apply it right away, select the Disable the
schedule check box. To later enable the schedule, clear the check box.
5. If you want to override the default values that you defined for the agent (p. 33), under Prompt
values, select the check box.
6. Click OK.

Specify Default Options for an Agent
Specify default options for an agent when you want every task in the agent to use the same values
for
• report task options (p. 26)
• content maintenance options (p. 30)

Steps
1. From the Actions menu, click Set Default Options for All Tasks.
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The Select agent default options dialog box appears.
2. Specify the default options you want.
3. From the File menu, click Save.
In Cognos Connection, you can change the defaults that are set for agents in Event Studio, such as
whether to use prompt values and run the agent as owner. For more information, see the Cognos
Connection User Guide.

Enable User Subscriptions to the Notification List of the
Agent
You can specify that you want Cognos Connection users to be able to add their email addresses to
the agent notification list.
When the agent runs, the notification list is added to the Bcc box in all emails sent using email
tasks or report tasks.
For information about how to add your name to a notification list, see the Cognos Connection
User Guide.

Steps
1. From the Actions menu, click Manage Notification List.
2. Select the Allow users to subscribe to the notification list check box.
Tip: If you want to remove everyone from the notification list, click Remove all.
3. From the File menu, click Save.

Change the Order in Which to Run Tasks
You can change the order in which to run tasks. By default, all tasks run at the same time. These
are called parallel tasks. If some tasks require a significant amount of processing time, parallel
tasks can save time.
You can also specify that one task finishes before the next task begins, and so on.
For example, an agent runs a report task that saves a prompted report. Next, the agent runs an
email task and attaches the saved report. For more information, see "Tutorial - Creating an
Agent" (p. 39).

Steps
1. In the I want to area, click Reorder the tasks.
2. Choose whether to specify the order or run all tasks at the same time:
• To run the tasks in a specific order, click In sequence and, in the Tasks box, click tasks
and change their order by clicking Up or Down.
Tip: If your agent has an email task that attaches a report created by a report task, the
agent performs the report task before the email task, regardless of their order. For more
information, see "Customize the Report" (p. 26).
• To run all the tasks in parallel, click All at once.
3. Click OK.
4. From the File menu, click Save.

Modify an Event Condition
Modify an event condition when you want to change the data instances that prompt the agent to
perform its tasks.
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Steps
1. In Cognos Connection, click the edit agent button for the agent you want to modify.
2. In the summary area, click the Event tab.
3. Change the values as required. For more information about the values required for an event
condition, see "Specify an Event Condition" (p. 21).
4. From the File menu, click Save.

Modify or Delete a Task
Modify or delete a task when you want to make changes to any of the tasks in the agent.
If you want to add a task, in the I want to area, click Add a task, and click a task type. For more
information, see "Adding Tasks" (p. 23).

Steps
1. In Cognos Connection, click the edit agent button for the agent you want to modify.
2. If you want to modify a task, do the following:
• In the summary area, under Tasks, click the tab for the task you want.
• Change the values as required. For more information about the values required for each
type of task, see "Adding Tasks" (p. 23).
3. If you want to delete a task, do the following:
• In the summary area, under Tasks, click the tab for the task you want to delete.
• From the Edit menu, click Delete.
4. Save the agent.

Modify the Task Execution Rules
Modify the task execution rules when you want to change the list of event instances for which a
task is performed.

Steps
1. In Cognos Connection, click the edit agent button for the agent you want to modify.
2. In the I want to area, click Manage the task execution rules.
3. Change the values as required. For more information, see "Specify the Task Execution
Rules" (p. 31).
4. If you want to reset the task execution rules to the default values, from the Actions menu,
click Remove Task Execution Rules.
The task is performed for new instances of events and all ongoing instances of events.
5. From the File menu, click Save.

Test an Agent
Before you run an agent, you can test whether the following conditions are met to increase the
chance that the agent runs successfully:
• The event condition is a valid query expression.
• All parameters are satisfied correctly.
• All referenced data items exist.

Steps
1. From the Actions menu, click Validate.
The View the validation results dialog box appears.
2. If an error message appears, fix the error and then repeat steps 1 to 2.
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If an error message appears when you run the agent, write down the error message and
troubleshoot the problem.
For more information, see the Cognos 8 Troubleshooting Guide.
3. When the No Errors message appears, click OK.
The agent is now ready to run (p. 36).

Run an Agent
You can run an agent in Cognos Connection when you want to check for event instances and
perform tasks if those events occur.
For example, an agent is created to send an email to sales staff in a particular region when they
reach 75 percent of their sales quota for the month. The agent prompts for the sales region. A
sales manager specifies Spain, and emails are sent only to sales staff in Spain.
Run an agent manually if you do not want to wait until it runs according to a schedule (p. 33).
You must have execute permission to run an agent. You must have traverse permissions for the
folder that contains the agent.
If you want to ensure that every event instance is assigned a status of new when the agent runs,
remove previous event instances by resetting the event list (p. 36).

Steps
1. In Cognos Connection, in Public Folders or My Folders, click the run with options button on
the actions toolbar next to the agent you want to run.
2. Under Time, click Now or click Later to specify a later date and time.
3. If you want the agent to prompt for values to filter the results it retrieves, under Prompt
Values, select the Prompt for values check box.
4. Click Run.
You are prompted for values if the agent includes prompts or if you have access to multiple
data source connections or signons.
5. If prompts appear, respond appropriately.
6. Click OK.
The options that you specified override the default agent options only for the current run.
You can view the run history of the agent in Cognos Connection. For more information, see the
Cognos Connection User Guide.

Remove Previous Event Instances for an Agent
If you want to ensure that every event instance is assigned a status of new the next time that an
agent runs, remove previous event instances by resetting the event list.
You may want to reset the event list if you edit the event condition such that it no longer makes
sense to compare the current event list with the previous one. Resetting the event list can also help
you to test the behavior of the agent when it detects new items.
Before you can reset the event list, you must define an event condition (p. 21). You must also run
the agent (p. 36) at least once.
To remove previous event instances for an agent, do the following:
• From the Actions menu, click Reset event list.

Working With Agents in Cognos Connection
You can continue to work with agents in Cognos Connection.
You can view the run history of the agent, which shows when the agent ran and whether it ran
successfully.
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You can create an agent view if you want to share the agent with another user. You can then give
the agent view different properties, such as prompt values. You can also run it as owner. If you
want to change the properties of an agent and do not need to retain an agent with the original
properties, you can simply change the default agent properties.
You can make a copy of the agent if you want to use the copy as the basis for a new agent.
You can create a shortcut if you want the agent to appear in more than one location.
For more information, see the Cognos Connection User Guide.
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This tutorial shows how the various tasks in creating an agent are related to each other. It shows
that managing task execution rules is performed for each task in an agent, but that specifying an
event condition is performed once for an agent.

Scenario
You are the Director of Sales at The Great Outdoors Company. The Finance department identified
a problem with invoice payments. Analysis of warehouse data shows that a large proportion of
late payments are by customers who returned damaged or faulty items and did not receive
replacements.
Customers tend to withhold payment for the entire order even if only one or two items are in
dispute. They may even refuse to pay for other completed orders until the disputed order is
resolved.
Therefore, rapid resolution of the returns issues has a direct effect on cash flow. The Director of
Finance asks you to establish a process that closely monitors data for problems with high rates of
return and takes immediate action to resolve any problem it detects.

Solution
You decide to use Event Studio to detect event instances and notify the people who must quickly
resolve the issue.
You create an agent named high_returns_followup. The agent detects cases where the actual value
of returned products is greater than the threshold value that the person running the agent defines.
You include a parameter in the event condition to represent this threshold value. Initially, you
concentrate on large return orders because they have the greatest effect on cash received. After you
address problems with the largest returns, you monitor lower valued returns.
To provide sales representatives with retailer contact information, you decide to add a report task
that runs the Retailer Contact report. The sales representatives can then quickly call the retailer
and try to resolve the issue.
Because you want to provide summary information in the email message to the sales
representatives, you decide not to email the report from the report task. Instead, you enable the
report as an attachment in an email that will be sent by an email task.
When you add the email task, you specify that the email message be in HTML format. When you
edit an HTML message, you can click a button that inserts a table. You list return values by order
number in the table. Then you attach to the email message both the report that you saved in the
report task and the event list that shows the event instances for which the agent performed its
tasks.
To create this example agent, perform the following tasks:
Start Event Studio and select the Go Sales and Retailers package.

❑
❑
❑
❑
❑

Define a parameter named total_return_value (p. 40).
Define a calculation named total_return_value_calc (p. 40).
Specify an event condition that contains the calculation and parameter (p. 41).

Add a report task that saves a report customized with contact information for the retailers
who returned the products (p. 42).
❑ Change the task execution rules for the report task (p. 43).

❑ Add an email task that sends an email to the sales representative for the returned product
(p. 43). Attached to the email is the report saved previously by the report task.
❑ Change the task execution rules for the email task (p. 44).
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❑ Add a news item task that publishes a dynamic headline that shows the current value of
preventable returns (p. 45).

❑ Schedule the agent (p. 46).
❑ Save the agent (p. 46).
❑ Run the agent (p. 46).

Example - Start Event Studio
You want to start Event Studio and ensure that your agent uses a data package that it can monitor
for the events you want and that it can use to perform tasks.
You decide to use the Go Sales and Retailers package because it contains data items related to
returned products, retailers, and order details.

Steps
1. In Cognos Connection, at the top of the window, click the Event Studio link on the toolbar.
2. In the Select a package window, click Go Sales and Retailers.
Event Studio opens in a new window. The data items you can use are listed in the Insertable
Objects area.
Tip: If you want to continue working in both Event Studio and Cognos Connection, you can
keep both windows open.
The next step in the creating an agent tutorial is to define a parameter.

Example - Define a Parameter
You want to define a parameter named total_return_value that you can insert into an event
condition.

Steps
1. From the Insert menu, click Parameter.
2. In the Parameter name box, type
total_return_value
3. Clear the Accept multiple values check box.
4. Click OK.
Tip: To see the parameter, in the Insertable Objects area, click the parameters tab.
The next step in the creating an agent tutorial is to create a calculation.

Example - Define a Calculation
You want to define a calculation named total_return_value_calc that you can insert into an event
condition. This calculation must determine the total value of each order returned.

Steps
1. From the Insert menu, click Calculation.
2. In the Name box, type
total_return_value_calc
3. In the Expression box, do the following:
• In the Insertable Objects area, click the functions tab.
• Expand Summaries, click the total summary item, and drag it to the Expression box.
• Click the source tab and expand Orders.
• Under Orders, expand Returned items.
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•
•

Click the Return quantity measure item, and drag it to the end of the expression.
After the source item you just inserted, type an asterisk:
*
• Under Orders, click the Unit sale price measure item, and drag it to the end of the
expression.
• At the end of the expression, type
for
• Under Orders, click the Order number dimension item, and drag it to the end of the
expression.
• At the end of the expression, type a closing parenthesis:
)
The calculation expression is defined as follows:

total ([gosales_goretailers].[Orders].[Return quantity]
* [gosales_goretailers].[Orders].[Unit sale price] for
[gosales_goretailers].[Orders].[Order
number])

4. Click OK.
The calculation appears as a calculation icon on the data items tab.
The next step in the creating an agent tutorial is to specify an event condition.

Example - Specify an Event Condition
You want the agent to detect cases where the actual value of returned products is greater than the
threshold value that the person running the agent defines.
Also, you want to see what parameter value would return an event list of between 5 and 10 items
from the current data.

Steps
1. Click the Detail tab.
2. On the data items tab, click the total_return_value_calc calculation that you defined
previously (p. 40), and drag it to the end of the expression.
3. At the end of the expression, type a greater than symbol:
>
4. Click the parameters tab, click the total_return_value parameter that you defined previously
(p. 40), and drag it to the end of the expression.
5. At the end of the expression, type
and
6. In the Insertable Objects area, click the source tab.
7. Click the Return quantity measure item, and drag it to the end of the expression.
8. After the source item you just inserted, type
> 0 and
9. Click the source tab, and under Returned items, click Reason description, and drag it to the
end of the expression.
10. At the end of the expression, type
in
11. If you want to include only the description types you want, do the following:
• On the source tab, under Returned items, click Reason description.
• Next to the Expression box, click the select value button.
• In the Select Value window, use Ctrl+click to select Incomplete product, Unsatisfactory
product, and Defective product.
• Click the insert button, and click OK.
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The detail expression appears as follows:
[Return quantity] > 0 and [total_return_value_calc] >
?total_return_value?
and [Reason description] in ('Incomplete
product','Unsatisfactory
product','Defective product')

12. Do the following to see whether an event list of between 5 and 10 items is returned when the
total return value calculation exceeds $17,000:
• From the Actions menu, click Preview.
• On the report viewer Prompt pages, in the Provide a number box, type
17000
• Click OK.
The data contains the following event instances.

total_return_value_calc

Return
quantity

Reason description

18,090.36

36

Unsatisfactory product

18,645.1

2

Defective product

18,645.1

32

Unsatisfactory product

22,200

32

Unsatisfactory product

40,159.7

70

Unsatisfactory product

94,454.36

154

Unsatisfactory product

The next step in the creating an agent tutorial is to add a report task.

Example - Add a Report Task
Sales representatives must ensure that items returned for a preventable reason are not returned
again for the same reason. You want to save a report of retailer contact information associated
with the excessive rate of return event that you defined. Sales representatives can use this
information to contact the retailer, discuss how to prevent future returns, and then take the
appropriate action.
You decide to add a report task that runs the sample report named Retailer Contact. When the
agent runs the report task, the value of the Retailer name data item for each event instance is
passed to the report output.
Instead of directly emailing the report using the report task, you specify that the report can be
attached to an email sent by an email task. By adding an email task, you can include additional
information in the email message that you cannot include using the report task.

Steps
1. In the I want to area, click Add a task.
2. Click Report.
3. Specify the report that you want to run:
• Click Public Folders, and click Go Sales and Retailers.
• Click Report Studio Report Samples.
• Click the last page button.
• Click Retailer Contact (Multiple Prompt Values) and click OK.
4. Under Options, click Set.
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5.

Specify the run options that you want:
• Select the Override the default values check box.
• Under Formats, select the PDF check box and ensure that none of the other check boxes
are selected.
• Under Delivery, select the Save check box, and ensure that Save the report is selected.
• Under Delivery, select the Enable attachment of the report in email tasks check box.
• Click OK.
6. Specify the prompt values that you want:
• In the Method column, click Use an item.
• In the Insertable Objects area, click the source tab and expand Retailers.
• Click Retailer name, and drag it to the Value box.
7. Save the agent (p. 46).
The next step in the creating an agent tutorial is to change the task execution rules for the report
task.

Example - Change the Task Execution Rules for a Report Task
The status of each event instance is obtained by comparing the event instances of the current run
of the agent to those of the previous run. You want to specify which event statuses will cause the
agent to perform the report task.
You know that for the event condition you specified, the Product name, Retailer name, and Order
method data items have duplicate values in two or more event instances. However, because the
Order number data item has a different value for each event instance, you choose it as the event
key.
You decide that the report task that you added previously (p. 42) should be performed for both:
• new event instances
New event instances are detected when the agent runs and were not detected the previous time
the agent ran.
• ongoing event instances in which the return quantity has changed
Ongoing event instances are detected when the agent runs and were also detected the previous
time the agent ran. In this case, only ongoing event instances in which the return quantity has
changed cause the report task to run.

Steps
1. In the summary area, click new report.
2. In the I want to area, click Manage the task execution rules.
3. On the source tab, under Orders, click Order number, and drag it to the Specify the event key
box.
4. Click Next.
5. Choose the event status for which the report task is performed:
• In the Select when to perform each task dialog box, select the New events and Ongoing
events check boxes.
• Under Ongoing events, click the box below the All button, and click Change.
• In the Insertable Objects area, click Return quantity and click the insert button.
6. Click Finish.
7. Save the agent.
The next step in the creating an agent tutorial is to add an email task.

Example - Add an Email Task
You want to notify sales representatives about orders that have a high rate of return.
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You decide to add an email task. You specify that the email message use HTML format. When you
edit an HTML message, you can click a button that inserts a table. You list return values by order
number in a table. Then you attach to the email message both the report that you saved previously
(p. 42), and the event list showing the event instances for which the agent performed its tasks.

Steps
1.
2.
3.
4.
5.
6.

7.

8.

9.
10.

11.
12.
13.
14.

In the I want to area, click Add a task.
Click Email.
Click the source tab, and expand Sales reps.
Click Email and drag it to the To: box.
In the Subject box, type
Urgent: Please contact retailer
In the Body box, type:
Please contact your retailer about the following returned order(s), and determine how to
prevent it from happening again
Add a table to the Body message:
• Click the insert table button.
• Type 4 in the Number of columns box, type 2 in the Number of rows box, and click OK.
Type the column headings in the first row:
• In the first cell, type Order Number.
• In the second cell, type Value returned.
• In the third cell, type Reason description.
• In the fourth cell, type Retailer name (see attached contact information).
Select the heading row, and click the bold button.
Enter data items in the second row:
• Click the source tab, and under Orders, click Order number, and drag it to the first cell.
• Click the data items tab, click total_return_value_calc, and drag it to the second cell.
• Click the source tab, click the menu scrollbar, expand Returned items, click Reason
description and drag it to the third cell.
• Click the menu scrollbar, click Retailer name and drag it to the fourth cell.
In the Body box, after the table, type
Thanks, the GO Sales Customer Loyalty Team
Click Attach, and click Attach the event output.
Click Attach, and click Attach the report Retailer Contact (Multiple Prompt Values).
Save the agent.

The next step in the creating an agent tutorial is to change the task execution rules for the email
task.

Example - Change the Task Execution Rules for an Email Task
The status of each event instance is obtained by comparing the event instances of the current run
of the agent to those of the previous run. You want to specify which event statuses will cause the
agent to perform the email task.
You know that for the event condition you specified, the Product name, Retailer name, and Order
method data items have duplicate values in two or more event instances. However, because the
Order number data item has a different value for each event instance, you choose it as the event
key.
You decide that the email task you added previously (p. 43) should be performed only for event
instances that did not appear in the event list the last time the agent was run.

Steps
1. In the summary area, click new message.
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2. In the I want to area, click Manage the task execution rules.
3. Click Next.
4. In the Select when to perform each task dialog box, select the New events check box and
ensure that none of the other check boxes is selected.
5. Click Finish.
6. Save the agent.
The next step in the creating an agent tutorial is to add a news item task.

Example - Add a News Item Task
The Customer Fulfilment manager wants to be informed of the current preventable returns.
However, he does not always check his email. He prefers to view important updates on a Web
dashboard that he checks regularly.
You decide to add a news item task that updates a headline with the total value of returns that are
preventable. That is, you publish the values of products returned because they are incomplete,
defective, or unsatisfactory.

Steps
1. Create a folder named High Returns.
• In Cognos Connection, click the new folder button.
• In the Name box, type High Returns
• Under Location, click Select My Folders.
The High Returns folder appears in My Folders.
2. In Event Studio, in the I want to area, click Add a task.
3. Click News Item.
4. In the Headline box
• Type Total Preventable Returns is
• Drag the calculation data item total_return_value_calc to the end of the text you just
typed.
5. Under Link to, choose what you want to link to:
•
Click Select an entry.
• Click Public Folders, and click Go Sales and Retailers.
• Click Report Studio Report Samples
• Click the last page button.
• Click Retailer Contact (Multiple Prompt Values) and click OK.
6. Under News list location, click Select a location, go to the High Returns folder in which the
news item will be published and click OK.
7. Under Run this news item for the events, review the event status that will cause the news item
to be published.
8. From the File menu, click Save.
When the agent performs the news item task, it publishes the news item to the My Headlines
folder.
The description text appears when you set your Cognos Connection preferences to use the details
view. The screen tip appears when you pause your pointer over the icon for the entry in the news
list location.
The next step in the creating an agent tutorial is to schedule an agent.
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Example - Schedule an Agent
When the excessive rate of return event you defined occurs, significant potential revenue has
already been lost. Following up on returned products increases your shipping charges and
administration fees. However, the most important impact of returned products is that they can
reduce customer loyalty and decrease your future sales. Therefore, it is important that you
respond quickly to an event instances as soon as it occurs.
You decide that you can provide a timely response to event instances by monitoring the data
hourly. You also decide that $17,000 is an appropriate threshold value for this initial schedule.

Steps
1.
2.
3.
4.

In the I want to area, click Schedule the agent.
Under Frequency, click By Day, and ensure that the frequency is Every1 hours(s).
Under Start, select tomorrow’s date, and specify the time as 9:00 AM.
Under End, click No end date.
Tip: You can edit the schedule later if you want to add an end date.
5. Under Prompt values, select the Override the default values check box, and then click Set.
6. On the prompt page, in the Provide a number box, type
17000
7. Click OK twice.
A schedule is created and the high_returns_followup agent runs hourly, starting tomorrow at 9:00
a.m.
The next step in the creating an agent tutorial is to save an agent.

Example - Save an Agent
You want to save the agent in My Folders. You also want to give the agent a meaningful name and
description so that you can easily distinguish it from other agents.

Steps
1. From the File menu, click Save.
2. If this is the first time you are saving the agent, in the Save As dialog box, describe the agent:
• In the Name box, type
high_returns_followup
• In the description field, type
This agent checks for orders that have a high value of returned products; It then sends a
report by email to the appropriate sales reps so that they can contact the retailers and
prevent future returns
• Ensure that the Location is set to My Folders.
• Click OK.
The agent high_returns_followup appears in My Folders, next to an agent icon.
The next step in the creating an agent tutorial is to run an agent.

Example - Run an Agent
You decide to run the agent immediately to test the results.
If you want to successfully run the agent described in this tutorial, you must first perform the
tasks in all the other examples. For more information, see "Tutorial - Creating an Agent" (p. 39).
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Steps
1. In Cognos Connection, in My Folders, click the run with options button on the actions
toolbar next to the high_returns_followup agent.
2. Under Time, click Now.
3. Under Prompt Values, select the Prompt for values check box.
4. Click Run.
5. On the Prompt page, in the Provide a number box, type
17000
6. Click OK twice.
The high_returns_followup agent runs using the prompt value you entered. To see the results of
the run, you can review the run history of the agent. For more information, see the Cognos
Connection User Guide.
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Glossary
agent
The object type created and edited by Event Studio. An agent contains the event condition and the
associated tasks to perform. Once defined, an agent can be scheduled to check for instances of the
event.

burst
To create many report results by running a single report once. For example, you can create a
report that shows sales for each employee, and run it once, sending different results to regional
managers by bursting on region.
You set up bursting in Report Studio and enable it in the portal.

event
An exceptional item of data, defined by specifying a query expression against items in a package.
When data is detected matching the event condition, it causes an agent to perform tasks.

event key
A combination of data items that uniquely defines an event instance. Identifying an event instance
enables the agent to determine if it is new, ongoing or stopped. The task execution rules then
determine which tasks to execute for each instance.

event list
The set of detected event instances evaluated by the task execution rules to determine which agent
tasks should be performed.

job
A group of runnable objects, such as reports, agents, and other jobs that you run and schedule as
a batch.

news item
A single entry in a rich site summary (RSS) compatible format. It can include a headline, text, and
a link to more information. A news item task in an agent can be used to create news items for
display in a Cognos Connection portlet.

package
A subset of a model, which can be the whole model, to be made available to the Cognos 8 server.

really simple syndication
See rich site summary.

rich site summary
An industry standard format for displaying transient data, such as breaking news, in a web page
or standalone viewer. Cognos Connection includes a portlet type for displaying RSS format data.
This can be used to display data from a public RSS service or to display news items generated by
agents detecting events. A synonym for Really Simple Syndication.

task
An action performed by an agent if the event status meets the task execution rules. For example,
an agent can send an email, publish a news item, or run a report.
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task execution rules
User-specified options within an agent that determine which statuses cause a task to be run. Each
event instance can have one of four statuses: new, ongoing-changed, ongoing-unchanged, or
stopped.

Web services
Web services are software programs that interact with one another, usually to exchange
information. Web services use standard Internet protocols such as XML, Simple Object Access
Protocol (SOAP), and Universal Description, Discovery and Integration (UDDI) to build
connections between systems.
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